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iD14 delivers the audio performance of 
a large format console in a compact and 
elegant desktop package. 

iD14 provides a pair of world-class Audient 
console mic pres, class leading Burr-Brown 
converter technology, console style monitor 
control, JFET D.I and the revolutionary 
ScrollControl . 

With its versatile feature set and intuitive 
layout, iD14 will become the hub of your 
studio in no time.

Features include:

• 2-in, 4-out high performance    
Burr-Brown AD/DA converters

• 2 x Class-A Audient Console Mic        
Preamplifiers & 1 x discrete JFET         
instrument input.

• Independant Class-AB Headphones    
Output

• Full Monitor Control Functionality 
(software controlled)

• iD ScrollControl  Mode

• ADAT Input for Expandibility

• USB2.0 class compliant connectivity   
with integrated Low Lateny DSP mixer

WELCOME & THANK YOU

Thank you for purchasing
this Audient product!

Introduction
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BOX CONTENTS

In your iD14 packaging you should find the 

following items:

• iD14

• 12VDC PSU with regional adapters

• USB Type A-to-B Cable

• Quick Start Guide

Please visit:

www.audient.com/products/iD14 

to download the latest iD software 

(mixer application and drivers), supporting 

documentation (including this manual) 

and brochures for our product range.

The 12VDC power supply comes with 

interchangeable  UK, EU, US and Australian 

socket adapters and will work across a broad 

range of line voltages making iD14 globally 

portable.

We hope that you enjoy using iD14!
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ID14 OVERVIEW
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Important Safety Instructions

Please read all of these instructions and save them for later reference before connecting

the DC power adapter to the mains and powering up iD14.

To prevent electrical shock and fire hazard follow all instructions on the 12VDC power supply. 

iD14 itself does not operate with any high voltage mains supply inside the unit but appropriate 

safety measures should still be adhered to regarding the AC/DC supply.

Please ensure you only use the supplied iD14 power supply. We cannot reccomend the useage  

of third party power supplies. In the event of a power supply failure do not open the 12VDC 

supply. Please contact Audient support so that a suitable replacement can be recommended 

or purchased. 

www.audient.com/support

iD14 utilises an external switch-mode power supply that is very quiet and rated at 1.25A. This 

switch-mode design will accept any A.C line voltage from  90v to 264v @ 47-63Hz. Therefore 

the unit will work anywhere in the world but please ensure your A.C mains line voltage is within 

this specification.

Consult a qualified technician if you suspect difficulties. Do not attempt to tamper with the 

power supply or mains voltages - HAZARDOUS TO HEALTH. Ensure that the appropriate

international pin adapter is fitted to the power supply before insertion into the mains socket.

SAFETY INFORMATION

! WARNING !

TO REDUCE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPARATUS TO 

RAIN OR MOISTURE.

NO USER SERVICEABLE PARTS INSIDE. 

PLEASE REFER SERVICING TO  QUALIFIED SERVICE PERSONNEL.
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SAFETY INFORMATION

Important Safety Instructions

1.  Read these instructions

2. Keep these instructions

3. Heed all warnings

4. Follow all instructions

5. Do not use this equipment near water

6. Clean only with dry cloth

7. Do not install near any heat sources such as radiators, heat registers, stoves, or other  

 equipment (including amplifiers) that produce heat

8. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized

 plug has two blades with one wider than the other. A grounding type plug has two  

 blades and a third grounding prong. The wide blade or the third prong are provided for  

 your safety. If the provided plug does not fit into your outlet, consult an electrician for  

 replacement of the obsolete outlet

9. Protect power cords from being walked on or pinched particularly at plugs, 

 convenience  receptacles, and the point where they exit from the equipment

10. Only use attachments/accessories specified by the manufacturer

11. Unplug this equipment during lightning storms or when unused for long periods of time

12. Refer all servicing to qualified service personnel. Servicing is required when the 

 equipment has been damaged in any way, such as power supply cord or plug is 

 damaged, liquid has been spilled or objects have fallen into the equipment, the

 equipment has been exposed to rain or moisture, does not operate normally, 

 or has been dropped

13. For products that are a mains powered device: The equipment shall not be exposed

 to dripping or splashing and no objects filled with liquids (such as vases) shall be

 placed on the equipment
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FCC Part 15B

This apparatus has been tested and found to comply with the limits of a class-A digital device, 

pursuant to Part 15B of the FCC Rules. These limits are designed to provide reasonable

protection against harmful interference in a residential installation. This equipment generates, 

uses and can radiate radio frequency energy and, if not installed and used in accordance with 

the instructions, may cause harmful interference to radio communications. If this equipment 

does cause harmful interference to radio or television reception, which can be determined by 

turning the equipment off and on, the user is encouraged to try to correct the interference by 

one or more of the following measures:

 1. Re-orient or relocate the receiving antenna

 2.  Increase the separation between the equipment and receiver

 3.  Connect the equipment into an outlet on a different circuit from that 

  to which the receiver is connected

 4. Consult the dealer or an experienced radio/TV technician for help

DECLARATION OF CONFORMITIES

  We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 
  01256 381944, declare under our sole responsibility that the product iD14 
  complies with Part 15 of FCC Rules. 

  Operation is subject to the following two conditions:

  1.  This device may not cause harmful interference,
  2.  This device must accept any interference received,

   including interference that may cause undesired operation

  Audient Ltd has conformed where applicable, to the European Union’s Directive    
  2002/95/EC on Restrictions of Hazardous Substances (RoHS) as well as the 
  following sections of California law which refer to RoHS, namely sections 25214.10,   
  25214.10.2, and 58012, Health and Safety Code; Section 42475.2, Public Resources

  We, Audient Ltd, declare that the product, the iD14, to which this declaration 
  relates, is in material conformity with the appropriate CE standards and directives
  for an audio product designed for consumer use.
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MAC OSX INSTALLATION

System Requirements

• OSX: 10.7.5 (Lion) or later

• Mac: Intel CPU, 1GB RAM Minimum

1. Download the Latest iD Software

Head to our website for the latest version of 

our iD Mixer:

www.audient.com/products/downloads/iD14

Drag the downloaded app into your 

application folder to install it.

2. Connect iD14

Using the USB cable provided, connect 

iD14 to your computer’s USB port.

Optionally connect the 12VDC power 

adapter if you require Phantom Power.

USB

12VDC
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3. Status LED

Once connected to your computer and 

powered on, the green status LED on iD14 

will illuminate.

If at any time the status LED turns off 

during normal operation please check all 

connections and if further problems develop 

please contact Audient support.

4. Double Checking Connectivity 

To ensure iD14 has been detected by your

computer and correct clocking sources are 

set-up, navigate to:

Macintosh HD > Applications > 

System Preferences

Check that iD14 is set as your i/o device.

It’s recommended to disable system sounds.

It’s also worth checking Audio MIDI Setup

(found in Mac HD > Applications > Utilities).

Window > Show Audio Window

Here you should see iD14 report with 10 

inputs and 4 outputs. Clock source is 

configured in the iD app. See page 23 for 

more details.

MAC OSX INSTALLATION
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Windows System Requirements:

• Windows 7 or later (32 and 64 bit)

• Intel Core 2 @ 1.6 GHz, or AMD   

equivalent

• 1 GB RAM Minimum

1. Download the latest iD14 Software

Head to our website for the latest version of 

our iD Windows Installer:

www.audient.com/products/downloads/iD14

2. Connect iD14

Using the USB cable provided, connect 

iD14 to your computer’s USB port. 

Optionally connect the 12VDC power 

adapter if you require Phantom Power.

3. Run iD Mixer Setup

Double click on the installer to run the 

iD mixer setup and follow the onscreen 

instructions.

4. Reboot PC

Reboot your PC to make sure that all the 

drivers have been applied.

WINDOWS INSTALLATION
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4. Check Connectivity

The status LED will become solidly lit as soon 

as iD14 has achieved stable communication 

and should remain solidly lit during operation 

of the unit until power down. 

To double check the connection, go to PC 

sound settings by following:

PC Settings > Control Panel > Hardware 

and Sound > Sound

Here you can see whether iD14 is 

visible to the PC and you can make it 

the computers default sound device by 

pressing ‘Set Default’.

iD Icon

Once installed, the iD icon can be found in 

the Windows system tray (it may be in the 

hidden icons area):

• Double-click to open iD14 mixer window 

when iD14 is connected

• Right-click to quit or change sample 

rate, buffer size and latency settings

Latency refers to how often iD14 sends 

and receives its data, for example it is not 

possible to have a high latency setting and 

a low buffer size because the buffer would 

fill up with samples before iD14 has the 

chance to send them.

For mixing, latency of ‘Standard’ and buffer 

size of 256 should be perfect. For tracking, 

experiement with lower latency and buffer 

size values. How powerful your computer 

is, and how processor hungry your project 

is, will affect how low you can get the 

latency and buffer size settings before you 

get audio instability. 

Latency Modes:
  

  Minimum  1ms
  Low  2ms
  Standard 4 ms
  Relaxed 8ms
  Safe  16ms
  Extra Safe 32ms

WINDOWS INSTALLATION
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Launch the iD Mixer Application

Launch the iD14 mixer application

by finding it in the following folder:

Macintosh HD > Applications > iD

Start > All Programs > Audient > iD

For more information on the mixer 

application feature set, please refer to 

page 17 of this manual onwards.

Check for Firmware Updates

If your computer is connected to the internet, 

the iD app will check for firmware updates  

whenever a unit is connected. If there is a 

firmware update available then the iD app 

will notify you.

You can manual check for updates by going 

to the Help menu and selecting ‘Check for 

Updates’. It will notify you if you’re on the 

latest version of firmware. 

Firmware Update

When there is a firmware update, you can 

select ‘From audient.com’ to download the 

latest version automatically (or select ‘From 

file’ to install a local firmware file).

The latest version number will be retrieved

from our servers and will be displayed (as 

shown above). Press next to continue with 

the firmware update. Press ‘update’ to 

install it and once complete reboot iD14 to 

apply it.

 

MIXER APP & FIRMWARE UPDATE
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HARDWARE FEATURES

HARDWARE
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Microphone Preamplifiers
& Line Inputs

iD14 features two classic Audient 

microphone preamplifiers. These preamps 

are based on designs from Audient’s classic  

consoles and are the same that are used 

across our entire product range.

The design features discrete Class-A 

circuitry providing exceedingly low distortion 

and noise performance. From a sonic point 

of view, iD14 is fast, open and detailed.

NeutrikTM XLR/TRS Jack combi-connectors 

provide microphone and line inputs. The line 

inputs are padded through the microphone 

preamplfiiers.

NOTE

Due to power restrictions over USB and the 

requirements of the high quality mic pres and 

converters, phantom power is only enabled 

when using the 12V power supply. 

The microphone preamplifiers feature:

• 56 dB of clean gain

• 48v (±4V) phantom power rated at 

10mA/channel

• > 2.8kΩ input impedance which provides 

a punchy tone from any microphone      

transducer type

• Extra features such as a +10dB boost 

and polarity reverse can be  

accessed via the iD App (See page 19).

HARDWARE FEATURES
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Instrument Input

iD14 employs a discrete class-a JFET

instrument (D.I) input on channel one which 

is easily accessible on the front of the unit.

The JFET circuitry adds a tiny bit of colour 

and distortion to the signal, making it sound 

great on guitars and basses.

Plugging in a TS (tip-sleeve unbalanced)

jack will override the mic signal and turn 

channel one into a fully fledged, fantastic 

sounding instrument input with access to the 

polarity reverse (useful for phase alignment 

between a mic and D.I) and the +10dB boost 

for quiet inputs.

Digital Inputs

iD14 features an optical input 

connection. This can be set to operate as 

stereo optical S/PDIF or 8-channel ADAT 

(SMUX) via the System Panel in the iD mixer 

application. Both formats will operate at up 

to 96kHz sample rate.

Running in S/PDIF mode, the optical input

provides the option to integrate an external 

mic pre, allowing 2 channels of audio up to 

96KHz.

Running in ADAT mode, the optical input

provides a great way to expand to 10 inputs 

for recording via an external mic preamp 

such as an Audient ASP800. When using 

88.2kHz and 96kHz as a sample rate, you 

only have access to 4 channels of digital 

input (due to the way SMUX works).

For more information about system 

clocking please refer to pages 23 onwards.

HARDWARE FEATURES
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Speaker Outputs

iD14 has stereo speaker outputs on the 

back panel in the form of balanced TRS jack 

connectors. The outputs are impedance

balanced using the same topology as our

flagship console, the ASP8024.

The outputs are fed from high quality 

Burr-Brown DACs (Digital to Analogue 

Convertors) sending clean, linear audio  to 

your speakers, perfect for critical listening.

You can use these outputs for more than 

just speakers. A good example of this is if 

you want to use a dedicated headphone 

amplifier for multiple musicians, you can 

send out two mono, or one stereo from 

these outputs, This is configured in the iD 

mixer software.

Headphone Output

iD14 features a high current headphone 

amplifier which is fed by it’s own seperate DAC 

and can be accessed from the headphone 

jack on the front of the unit.

This can be used instead of or alongside 

speakers to get an idea how your mix 

sounds on headphones, or to provide artist 

headphone mix (or even to drive a small set 

of active loudspeakers at line level using an 

unbalanced Y-split cable. Please note that 

passive speakers cannot be driven without 

an external amplifier.)

The headphone output can comfortably 

drive a wide range of headphone 

impedances meaning that you will get great 

sounding audio no matter what model of 

headphones you have.

HARDWARE FEATURES
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Monitor Control

iD14 provides excellent monitor control 

functionality using the large aluminium 

encoder and the encoder buttons. 

As such, it is possible to control main 

loudspeaker and headphone volumes with a 

perfectly matched stereo volume control

on the main unit. 

The three encoder mode buttons allow you 

to change what the encoder controls. The 

button that is selected will be illuminated.

Loudspeaker and Headphone Buttons

Pressing the speaker or headphone button 

allows the encoder to control the level of 

the selected output. The volume of the 

output is displayed on the meter LEDs and a 

press of the encoder will mute the output.

When a selected output is muted, the 

encoder button will flash, that encoder 

buttons. 

iD Button

The iD button provides extra functionality 

in the form of an assignable function 

button, or it can be used to activate iD14’s 

ScrollControl  which turns the encoder into 

a virtual scroll wheel allowing you to control 

elements of your DAW (see page 22)

When the iD button is set as a function 

button, the encoder will continue to control 

the output that was previously selected. The 

iD button is assigned in the iD app.

HARDWARE FEATURES
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Hardware Metering

The 8-segment hardware meters indicate 

playback level of the iD mixer app, so it is 

suggested that end users observe their 

DAW metering for input levels.

Status LED

The status LED indicates connection via

USB to your computer. A solidly lit light 

means that there is stable communication 

between iD14 and your computer.

Kensington Lock

For those who work in educational

establishments or in situations where your 

equipment is public facing and subject 

to possible theft opportunities, we have 

provideda Kensington lock hole to enable 

you to protect your iD14.

HARDWARE FEATURES
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ID MIXER APP

SOFTWARE FEATURES
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Input Channels - Channel Types

The iD mixer application features three 

types of input channels, these are colour 

coded and are as follows:

• Analogue Inputs (Mic/Line 1-2) - BLUE

• Digital Inputs (S/PDIF or ADAT) - GREEN

• DAW Mixes (Playback 1-4) - PURPLE

Analogue input channels are taken 

from the microphone, line or D.I. (channel 

one) inputs.

Digital inputs are provided as two 

channels in S/PDIF mode and eight 

channels in ADAT mode (four at > 48kHz).

DAW inputs are provided as two stereo 

pairs and are designed as ‘virtual’ playback 

channels from your DAW. 

Setting outputs in your DAW will feed 

signals into these channels. For example if 

you send signal to ‘Output 1-2’ in your DAW, 

it will be seen in the meters of ‘DAW 1+2’ 

in the iD mixer. Then if you want to hear it, 

turn up the channel’s Main Mix Fader

Channel Naming Strip

The iD mixer application allows you to label 

your channels via the editable

marker pen text on console tape!

Double clicking on the channel name 

allows you to rename it using up to eight 

characters.

You could name it ‘Kick’ for example

SOFTWARE FEATURES
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Stereo Linking

All channels can be linked or unlinked for 

stereo or mono operation. Level controls 

are combined in stereo operation but ste-

reo pan control remains individual for left 

and right channels.

Useful Functionality

Every active control 

(buttons, pots or 

faders) in the iD mixer 

application feature 

colour coded mouse 

over indicators to help 

you quickly navigate 

and make adjustments.

All controls are also

scrollwheel enabled in

the iD mixer application.

Channel Strip Controls

• Unlinked

• Individual Level

• Individual Pan

• Linked

• Combined Level

• Individual Pan

Cue Send Controls
Level (0 dB to off)
Pan (if using stereo cue)
Alt + click to zero

Gain Boost
Supplies a +10dB gain 
boost for low level signals

Parameter Info Box
Normally displays main 
channel pan value but
if you hover the mouse
over any control - it will
display that parameter’s
value

Channel Solo & Cut
Latching operation

Cmd + click on Mac or 
Ctrl + click on Windows
on a solo switch, while on an 
un-solo’d channel will 
override any previously
solo’d channel

Cmd + click on Mac or 
Ctrl + click on Windows
on an already activated 
solo switch will clear all
solo’d channels

Channel Meter
66dB Range
Separate Peak Hold Indicator
Click on peak indicator to clear
Alt + click to clear all

Main Mix Fader
+6dB to off
Alt + click to zero

Channel Tape Label
Editable with up to 8 
characters

Polarity Invert
Flips polarity of that
channel.

SOFTWARE FEATURES
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Master Section
Cue Master
Level (0 dB to off)
Controls output level
of the summed cue sends

Alt + click to zero

Cue Master Solo
Use this cue solo
to audition artist mixes
quickly.

Talkback Button
Operating the talkback 
switch routes whichever 
input has been selected as
talkback (in system panel)
to the cue and to your 
DAW.

Channel View Buttons
Customise your mixer 
layout by including only the 
channels you are using

Mac Shortcuts:
cmd + 1 Mic/Line
cmd + 2 Optical
cmd + 3 Daw Mixes

Windows Shortcuts:
ctrl + 1 Mic/Line
ctrl + 2 Optical
ctrl + 3 Daw Mixes

Main Meters
66 dB Range

These meters indicate the 
output levels of the Main Mix 

bus within iD14. They are 
mirrored by the 8-segment 

hardware LED meters on the 
main unit

1dB steps from 0 to-6dBFS
2dB steps from -8 to -56dBFS

Separate Peak Hold Indicator
Click on peak indicator to clear

Alt + click peak to clear

System Panel Button
Opens the iD14 set-up and 

routing panel
(see page 23)

Mono Sum Button
Monitor the output

of the iD14 DSP mixer
summed to mono

Polarity Reverse Button
Invert polarity of one side

of the stereo monitor output
for stereo difference checks. 

This button automatically 
activates mono as well. 

Main Volume Control
Control the main output 

volume in software by 
draggingwith your mouse Headphone Level Knob

Control the headphone 
output volume in software 
by dragging with your 
mouse

Encoder Mode Icons
Icons display the mute states 
of the outputs (See page 21)

iD Mode
Right click to select what 
the iD button controls
(See page 22)

SOFTWARE FEATURES
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Channel View Settings

When tracking (without using a digitally 

expanded iD14) it is most likely that the 

following channel view (Analogue + DAW) 

would be the most useful, enabling you to 

see mic/line inputs and DAW returns:

Volume Control

The Main Mix of the iD mixer is sent to 

the outputs which are set-up as Main 

Mix in the Routing Matrix (see page 24). 

This is your monitor destination and 

should be connected to your main studio 

loudspeakers. This means that you need to 

turn the main mix fader up on any channel 

that you want to hear (for speaker output 

this is typcially just DAW 1+2).

To control the volume of an output, select 

the output using the correct encoder mode 

button then use the encoder (left image), or 

use the coresponding knob in the master 

section of the software (right image).

To mute an output, press the encoder 

quickly. If you only want it to mute 

momentarily then hold it down, and when 

it is released it will unmute the audio. In 

software, press the output icon to mute it.

When an output is muted the encoder 

button on the unit will flash, and in software 

the icon will be white.

SOFTWARE FEATURES

   

For simple monitoring /

listening or in the box 

mixing it may be cleaner 

to view just the master 

section. When fully 

expanded via ADAT with 

a device like an ASP800, 

you can view all channels 

(after 10 mono slots, a 

scroll  bar appears). 



22

Programming the iD Button

The iD button can be programmed to 

perform different functions (see below). This 

can be set by clicking on the iD icon in the 

master section of the iD App and selecting 

the function from the list of choices.

ScrollControl

This allows the encoder to be used as a 

scrollwheel for the computer. This allows 

you to control plugin parameters and 

anything else that is scrollable. This works 

well for adding automation or setting 

parameters in a hands on way.

To use ScrollControl, hover your mouse 

over whatever you want to control and 

rotate the encoder. 

ScrollControl may act slightly different on 

different plugins or DAWs depending on 

how they have been programmed to work 

with scrolling. If you find it is too sensitive 

or not sensitive enough, you can try adjust 

your computer scrolling speed.

Mono

A useful feature to check mono 

compatibility of mixes (important for DAB 

radio and laptop/tablet users)

Mono + Polarity 

This will cancel the centre (sum) of 

the stereo signal and leave behind the 

difference signal (L-R). Monitoring this 

provides a great way to listen to stereo 

content such as reverbs and also pick up 

tricks from your favourite mix engineers.

It is a very useful and different perspective

of the mix balance.

Dim

Provides a -15dB Dim which is useful if you 

want to quickly turn down the level to your 

speakers without changing the encoder and 

losing your monitoring level.

Talkback

Use the iD button to toggle talkback. See 

page 25 for information on setting up and 

using Talkback.

SOFTWARE FEATURES
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System Panel

The system panel is where all the settings 

of iD14 are configured. Here you can set 

the digital input settings, talkback channel 

assignement, mono mode, and output 

routing. It also allows you to save and load 

mixer presets which is useful if you have 

multiple configurations for the mixer.

To open the system panel, press the 

SYSTEM button found in the master

section or use Command  + 4 in

OSX, or Ctrl + 4 in Windows.

Clocking

If optically expanding iD14, you need to 

make sure it syncs with that device. The 

external device must be the master, so set 

the sample rate you want on that device, 

then set the iD14 preferred clock source to 

Optical. Look at the Clock source Status LED 

for the status of this connection.

Red - No external device or no clock signal detected
Amber - Detected but sample rates do not match.
Green - Valid clock source - iD14 will lock

Digital Input Format
Select 8-ch ADAT or 2-ch 

S/PDIF input modes for 
the optical input here.

ADAT 8-ch 44.1 - 48kHz, 
4-ch 88.2kHz - 96kHz.
S/PDIF 2-ch all rates

Clock Source
Select internal or optical input 

as the clock source. Ensure 
all sample rates match your 
DAW session and computer 

settings 

Clock Source Status LED
Indicates whether a valid 

clock source is present on the 
optical input

Talkback Assign
Select any available iD14

input (analogue or digital) to 
be the source for talkback 
and routed to cues. Mixer 

channel becomes talkback  
with no feedback possibility

Mono Mode
Set whether sum-to-mono

creates a mono sum in one 
loudspeaker (one acoustic 

source) or creates a ‘phantom 
centre’ sum (two acoustic 

sources) - they sound different

Save and Load
Save and load your own mixer 

configurations 

Routing Matrix
Select what is sent to either 

the main output or the 
headphone output.

SOFTWARE FEATURES
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Output Routing

The output routing matrix lets you patch the  

iD Mixer outputs to the physical outputs on  

iD14.

There are three sources that you can select 

for the physical outputs:

Main Mix

This is the main output of the iD mixer, so 

any channel in the mixer that is turned up 

and unmuted with signal will be present in 

the Main Mix. This is typically what is used 

for the speaker output.

Cue Mix

The cue sends on each channel are 

summed to the Cue Master found in the 

Master Section, the output of which is the 

Cue Mix. This is commonly used to create 

headphone mixes.

Daw Mix

This bypasses the iD14 monitor section 

hardwiring the signal from DAW to output. 

This stops the encoder from changing the 

volume of the audio and is the equivalent of 

having the volume set to full (so be careful 

when changing the speaker output to Daw 

Mix as it could be very loud!). 

This is useful if you want to do headphone 

mixes in the box rather than using the cue 

mixes or using an output as a hardware 

send for example.

WARNING!

When setting Cue or Daw Mix, be wary of 

the levels that are going into the speakers. 

Make sure to turn down the audio source 

(or Cue master when using the Cues) 

BEFORE selecting Cue/Daw mix and then 

turn it up to taste.

Example Setups

For more detailed explainations of setting 

up iD14, please visit the iD14 support page 

at:

www.audient.com/support

SOFTWARE FEATURES
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Assigning Talkback

When a channel is assigned as talkback 

source in the iD mixer application system 

panel, the selected mixer channel strip 

updates to become a talkback channel.

Channels will be presented in the talkback

assign menu as per their labelling in the 

mixer scribble strip (console tape). As such

they are easy to identify.

For many who record vocalists, one input 

for the artist will be enough so we suggest 

using a talkback microphone in Input 2, 

however any of the digital inputs can also be 

used.

Gooseneck Microphone Use

If recording a vocalist or 

drummer (with digital 

expansion) one microphone 

channel on the 

iD14 provides 

the perfect place 

to use a gooseneck 

talkback microphone. If it is a 

condenser gooseneck make sure you have 

the 12VDC power plugged in as phantom 

power cannot be used on bus power.

Talkback Channel Strip

When an assigned channel 

converts to talkback operation,

the cue send level and pan

remain, allowing you to route

the talkback signal to artists via

the cue mix. A routing box 

shows which active channel is

set as talkback.

A secondary talkback button

is located on the talkback

channel which can be used

to trigger talkback whilst

setting up the software mixer.

You can also assign the 

talkback switch to the iD button

in the master section.

SOFTWARE FEATURES
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Saving & Loading Mixer Presets

Mixer presets can be saved and loaded in 

two ways:

• Using the buttons at the bottom of the 

system panel

• Using standard keyboard shortcuts  

• Save: Mac - Cmd + S

  Windows - Ctrl + S

• Load: Mac - Cmd+ O

  Windows - Ctrl + 0

Saving a Mixer Configuration

You are able to save mixer configurations 

as a preset for easy access. Your preset 

can be named by double clicking in the box.

For information on where preset files are 

automatically saved, please visit our help 

desk.

By using the Save to File

button you can save

preset files to any

folder you desire - allowing you to contain 

them within your DAW session folder for 

example (making recall easier).

Loading a Mixer Configuration

Loading a preset is very simple, just click 

on the load button in the System Panel and 

select one of your previously named files, 

double clicking will also load a preset. To 

rename a preset, click to highlight and then 

after a pause, click again to rename. To 

delete, click to highlight and then click on 

the X (delete) button at the bottom.

SOFTWARE FEATURES
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Keyboard Shortcut Index

To allow you to find all shortcuts for the 

mixer application in one place without 

having to go through each page of this 

manual please refer to this table:

Location  Mac   Windows  Description

  

Faders  Alt + Click  Alt + Click  Resets fader to unity gain (0 dB)

Pans   Alt + Click  Alt + Click  Resets pan pots to central

         position 

Solos   Cmd + Click  Ctrl + Click  Clears all solos if clicking on a solo’d

         channel

         Overrides all other solos (for solo  

         exclusive) if clicking on an unsolo’d  

         channel

Meters  Alt + Click  Alt + Click  Clicking on peak hold indicator will  

         clear all clip indicators

System Panel Cmd + S  Ctrl + S  Save mixer configuration

   Cmd + O  Ctrl + 0  Load mixer configuration

View Modes  Cmd + 1  Ctrl + 1  View Mic/Line Inputs

   Cmd + 2  Ctrl + 2  View Optical (Digital) Inputs

   Cmd + 3  Ctrl + 3  View DAW Mix Inputs

   Cmd + 4  Ctrl + 4  View System Panel

Please check the iD14 page online at www.audient.com/products/iD14 
for the latest mixer application updates. 

More shortcuts may be added without notification.

KEYBOARD SHORTCUTS
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Operation with Pro Tools

Once iD14 has been successfully installed

following the steps detailed after page 6 of 

this manual, launch Pro Tools and ensure 

that a new session is created at the desired 

sample rate (if clocking internally) or at 

the rate of the clock source (if clocking 

externally).

If using Windows, make sure that you have 

set the correct latency and buffer size 

settings in the iD app before opening a 

project. Changing these settings will result 

in ProTools needing to restart.

Playback Engine

Go to Setup > Playback Engine... and ensure 

that iD14 is set as the active playback

device. 

I/O Setup

Go to Setup > I/O... to label your inputs and 

outputs and ensure that iD14 is correctly 

reporting 10-inputs and 4-outputs to and 

from Pro Tools. Note that analogue outputs 

1-4 are the DAW playback channels in the 

iD mixer and can either be routed through 

the iD mixer or hard-wired directly from Pro 

Tools to the physical outputs. 

For more Pro Tools information consult 

your Avid user manuals & documentation.

PROTOOLS SETUP
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Operation with Logic Pro

Once iD14 has been successfully installed 

following the steps detailed after page 6 of 

this manual, launch Logic Pro and check the 

following:

Logic Pro > Preferences > Audio

Ensure that iD14 is selected as the active

audio device and set the buffer size 

(to affect system latency). If you are 

experiencing issues with playback stability 

and CPU loading, try increasing the buffer 

size. This appears with “overload” errors 

and/or pops and clicks and distortion in the 

audio.

If you are using the iD mixer to monitor 

input signals while recording, be sure to 

disable Logic’s software monitoring to avoid 

phasing as the same source will be heard 

twice with a short delay between the low 

latency DSP signal and the delayed software 

monitoring signal.

Assigning I/O

All of iD14’s input and output channels will 

be available to Logic for routing. There are 

a total of 10-inputs and 4-outputs 

reported from the driver.

You can rename input 

and output channels to 

whatever you wish using 

the I/O label function. 

This is a great way to 

keep things organised.

Mix > I/O Labels

LOGIC PRO SETUP
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Operation with Logic Pro

If you are using an external clock source

(ADAT or S/PDIF) to clock iD14, please 

ensure that your Logic Pro project is set to 

the same sample rate when recording and 

playingback in a session, otherwise things 

may sound a bit sharp or flat!

File > Project Settings > Audio

If you are using the internal clock in iD14,

setting the sample rate via Logic Pro will 

update the iD14 sample rate to follow your 

session.

There may be a slight pause as the system

re-clocks. This is normal.

This can be verified in Audio MIDI Setup.

Macintosh HD > Applications > Utilities

For more Logic Pro information please 

consult your Apple user manuals & 

documentation.

LOGIC PRO SETUP
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Operation with Cubase / Nuendo

Once iD14 has been successfully installed 

following the steps detailed after page 6 of 

this manual, launch Cubase or Nuendo and 

head straight for the Devices menu:

Devices > Device Setup...

Select VST Audio System in the devices 

menu.

Select Audient iD14 in the menu to ensure 

that Cubase / Nuendo addresses the iD14 

device driver. You will be asked if this is OK, 

select ‘switch’.

Select Audient iD14 in the devices menu...

Here you will see the 

main iD14 information,

where clock sources

can be set as well as 

activating i/o ports.

Be sure to click 

Externally Clocked if 

clocking from another

digital device via ADAT or SPDIF.

CUBASE/NUENDO SETUP
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Operation with Cubase / Nuendo

Buffer sizes can be set in the control panel

within the VST devices display. It is ideal 

to keep them quite high to reduce CPU 

loading if you use the iD mixer as the input 

monitoring device while recording.

I/O ports can be renamed in the device

panel such that they better represent 

what you connect to them (for example 

Main Monitors, Headphones). This is useful 

as any names chosen here will be those 

displayed when assigning i/o on track 

input/output channel routing.

Close the VST device setup panel and 

navigate to the VST connections panel:

Devices > VST Connections (F4)

Here you can ensure that all buses have 

been created in Cubase / Nuendo and 

therefore all ports are addressable in your 

session. Add new buses and assign them 

to the necessary i/o if required.

Bus types can be set (mono / stereo) and 

the VST control room section can also be 

used. For more information regarding set-

up please consult your Steinberg user 

manuals and documentation.

CUBASE/NUENDO SETUP
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Operation with Ableton Live

Once iD14 has been successfully installed 

following the steps detailed after page 6 of 

this manual, launch Ableton Live and head 

straight to:

Live > Preferences

Here navigate to the Audio tab and make 

sure that iD14 is assigned as the playback

device.

   

   

   For more information   

   about setting up audio 

   i/o refer to your Ableton  

   Live user manuals &

   documentation.

In the Live Audio Preference panel you can 

set an appropriate buffer size (this can be 

kept high if you are monitoring input signals 

for recording via the iD mixer. Ensure that 

iD14 reports as a 10-in, 4-out device to 

Live. 

If necessary you can limit the number of 

i/o channels reported as active inputs 

(from the driver) in Live by using the input 

and output config tabs. This is an excellent 

feature to help reduce CPU loading if all 

channels are not required.

ABLETON LIVE SETUP
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Troubleshooting

• “The unit will not power on”

Double check that the USB cable is plugged 

in (and/or 12VDC power adapter). If it still 

won’t power on, try using a different USB 

port on the computer and possibly even a 

different USB cable. If you are using a USB 

hub, please try plugging iD14 directly into 

the computer.

• “I get clicks and pops on DAW playback”

This is most likely to do with setting the 

buffer size too low for your computer. 

This can be caused by running very large 

projects with a lot of plugins and virtual 

instruments. Experiment with higher buffer 

sizes (and Latency settings in Windows). 

Typically you want small buffer sizes for 

tracking or recording software synths to 

keep the latency low. However when mixing 

it is fine to set a slightly higher buffer size as 

latency is not so much of a problem.

• “When I connect to my computer,             

I cannot play any audio out from iD14”

Firstly double check that the USB cable 

connecting iD14 to your computer is

functional and attached at both ends.

Double check that iD14 is set as the active 

playback device in your DAW and computer:

System Preferences > Sound > Output Tab

> Audient iD14  (OSX)

Control Panel > Hardware and Sound > 

Sound > Manage Audio Devices > Audient 

iD14  (Windows) 

Launch the iD mixer application to 

activate communication between your 

computer and iD14. This only needs to be 

done once straight after power up. Once 

iD14 is set to the operational state you 

desire, you can quit the iD application and it 

will continue to function as intended.

In the software mixer, locate the DAW 

channels by pressing the DAW view button 

and increase the level of DAW 1+2 fader.

TROUBLESHOOTING & FAQ
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Troubleshooting

• “I have clocking issues which include 

iD14 not locking to external ADAT 

or SPDIF devices or operating at the 

incorrect rate compared to my session”

If there is an issue with syncing of an 

external device, the Status LED in the 

System Panel will be red or yellow. If the 

status light is red then iD14 cannot detect 

a clock signal from an external device, and 

yellow if it can detect a signal at the wrong 

sample rate. 

To change sample rate in OSX go to Audio 

MIDI Setup found by navigating to the folder:

Macintosh HD > Applications > Utilities > 

Audio MIDI Setup

Ensure that Audient iD14 is seen as an 

audio device (Window Menu > Show Audio 

Window).

Double check that an appropriate clock 

source is selected (Internal for master 

operation), ADAT or S/PDIF clock for 

external slave operation. Ensure that you 

see the correct sample rate displayed in 

the Format drop-down menu.

If you are using Windows, go to the iD icon 

in the system tray and right click on it. This 

will bring up some settings including sample 

rate. Alternatively you can alter these 

setting in the Setup tab of the iD app. 

Change the sample rate to match that of 

the external ADAT device and session.

TROUBLESHOOTING & FAQ
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Troubleshooting

• “How do I reset the iD mixer application 

to it’s default state?”

To reset the mixer application, quit the 

iD app completely, then navigate to the 

following folder and delete the state.xml file 

(it will replenish upon a fresh launch of the 

application)

Macintosh HD > User > Library > Application 

Support > Audient > iD > state.xml

(C:) > Users > yourusername > AppData > 

Roaming > Audient > iD > state.xml

Do not delete the parent folder as this will 

also contain your iD mixer presets.

• “How do I make sure I have the latest   

version of iD firmware/software?”

To check for the latest updates to the

iD desktop mixer application please visit:

www.audient.com/products/iD14 

download the package and install.

You will be made aware of firmware 

releases from the iD app when connected 

to the internet. Please refer to page 10 in 

this user manual for more information 

regarding firmware update.

FAQs

For more information and bug support,

please search our online Help Centre which 

can be found here:

www.audient.com/support

For technical support please create 

a ticket in our online support system, 

Zendesk which can also be found in the 

support section of our website 

(see link above).

 

TROUBLESHOOTING & FAQ
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SPECIFICATIONS

MICROPHONE PREAMPLIFIER: 
(measurement includes ADC signal path)

MIC GAIN:   0 to 66 dB (incl. +10 dB software boost)
LINE GAIN:   -10 to 56 dB (-10dB hardwired line pad)
PHANTOM POWER:   48V ±4V @ 10mA channel (12VDC only)
MIC EIN:    <-127.0 dBu
CMRR:    >80 dB @ 1kHz
MAXIMUM INPUT LEVEL:  +12 dBu (0 dBFS digital maximum)
INPUT IMPEDANCE (Mic): 2.8k Ω balanced 
INPUT IMPEDANCE (Line):  >8k Ω balanced
FREQUENCY RESPONSE: ±0.1 dB 20Hz to 22kHz @ min. gain
   ±1.0 dB 20Hz to 22kHz @ max. gain
CROSSTALK:   <-90 dBu
THD+N @ 0dBu (1kHz):  <0.0025% (-92 dBu)
SNR:    96 dB un-weighted, 99 dB A-weighted
XLR COMBI FEMALE:   Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield)
1/4” TRS JACK:  Tip (Hot), Ring (Cold) & Sleeve (Shield)

HEADPHONE OUTPUT / DAC 3 & 4: 
(Measured under AES-17 at phones output)

MAXIMUM OUTPUT LEVEL:  +12 dBu (0 dBFS digital maximum) 
DIGITAL REFERENCE LEVEL: +12 dBu = 0 dBFS
OUTPUT IMPEDANCE:  <30 Ω unbalanced
VOLTAGE GAIN:   +6 dB (optimised for loudness) 
FREQUENCY RESPONSE:  ±1.0dB 10Hz to Fs/2 (load dependent)
CROSSTALK:  <-100 dBu @ 1kHz & 10kHz 
THD+N @ -1dBFS (1kHz):  <0.002% (-94 dB)
DYNAMIC RANGE:  108 dB un-weighted, 111 dB A-weighted
MAXIMUM LEVEL into 30 Ω:  +4 dBu 0.005% THD+N Power: 101mW
MAXIMUM LEVEL into 60 Ω:  +5 dBu 0.004% THD+N Power: 64mW
MAXIMUM LEVEL into 600 Ω:  +13 dBu 0.0025% THD+N Power: 39mW
1/4” TRS JACK:  Tip (Left), Ring (Right) & Sleeve (Shield)

D.I / INSTRUMENT INPUT: 
(Channel 1)

D.I GAIN:    0 to 66dB (incl. +10dB software boost)
MAXIMUM INPUT LEVEL:  +9 dBu (0.6% THD typical) 
INPUT IMPEDANCE:   >500k Ω unbalanced
FREQUENCY RESPONSE:  ±0.1dB 20Hz to 22kHz
THD+N @ 0dBu (1kHz):  <0.04% all musical 2nd and 3rd harmonic 
SNR:    95 dB un-weighted, 98 dB A-weighted
1/4” TS JACK:  Tip (Hot) & Sleeve (Shield)

ANALOGUE TO DIGITAL CONVERTER (ADC 1 & 2): 
(Measured sans microphone preamplifier under AES-17)

MAXIMUM INPUT LEVEL: +12 dBu (0 dBFS digital maximum)
DIGITAL REFERENCE LEVEL: +12 dBu = 0 dBFS
FREQUENCY RESPONSE: ±0.1 dB 10Hz to Fs/2 (flat to nyquist)
CROSSTALK:  -100 dBu @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz): <0.002% (-94 dB)
THD+N @ -6dBFS (1kHz):  <0.0015% (-96.5 dB)
DYNAMIC RANGE:  113 dB un-weighted, 116 dB A-weighted

DIGITAL TO ANALOGUE CONVERTER (DAC 1 & 2): 
(Measured under AES-17 at line outputs 1 & 2)

MAXIMUM OUTPUT LEVEL:  +12 dBu (0 dBFS digital maximum)
DIGITAL REFERENCE LEVEL: +12 dBu = 0 dBFS
OUTPUT IMPEDANCE:  <100 Ω
FREQUENCY RESPONSE:  ±0.1 dB 10Hz to Fs/2 (flat to nyquist)
CROSSTALK:  <-105 dBu @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz):  <0.003% (-90.5 dB)
DYNAMIC RANGE:  114 dB un-weighted, 117 dB A-weighted
1/4” TRS JACK:  Tip (Hot), Ring (Cold) & Sleeve (Shield)

POWER SUPPLY: 
12VDC Centre Positive - 1.25A (required for full 48V Phantom 
Power

iD14 requires a lot of power for class leading converters and 
class-A microphone preamplfiers. We could not beat the laws of 
physics so anexternal supply is required for 48V phantom power. 
Your microphones will thank you when they get enough voltage!

DIGITAL INPUT: 

8-CHANNEL ADAT:  44.1kHz to 48.0kHz 
4-CHANNEL ADAT:  88.2kHz to 96.0kHz SMUX
STEREO S/PDIF / TOSLINK: 44.1kHz to 96.0kHz (Stereo)

USB2.0 HIGH SPEED: 

BUS POWER:   500mA @ 5V System Limit
   425mA @ 5V Maximum (No 48V)
   (Phantom power only available on 12VDC)

No. of INPUT CHANNELS: 10  (2 Analogue, 8 Digital)
No. of OUTPUT CHANNELS: 4 (4 Analogue)

DSP MIXER LATENCY: ROUND TRIP (in-to-out)
   44.1kHz 1.660ms
   48.0kHz 1.531ms
   88.2kHz 0.844ms
   96.0kHz 0.771ms
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Warranty Statement

Your iD14 comes with a manufacturer’s warranty for one year (12 months) from the 

date of despatch to the end user.

The warranty covers faults due to defective materials used in manufacture and faulty 

workmanship only.

During the warranty period Audient will repair at its discretion or replace the faulty unit 

provided it is returned carriage paid to an authorised Audient service centre. We will not 

provide warranty repair if in our opinion the fault has resulted from unauthorised modification, 

misuse, negligence or accident.

We accept liability to repair or replace your iD14 as described above. We do not accept 

any additional liability. This warranty does not affect any legal rights you may have against 

the person who supplied this product - it is additional to those rights.

Warranty Limitations

This warranty does not cover damage resulting from accident or misuse. The warranty is void 

unless repairs are carried out by an authorised service centre. The warranty is void if the unit 

has been modified other than at the manufacturer’s instruction. The warranty does not cover 

components which have a limited life, and which are expected to be periodically replaced for 

optimal performance. We do not warrant that the unit shall operate in any other way than as 

described in this manual.

Audient Ltd
Aspect House
Herriard
Hampshire
RG25 2PN
United Kingdom

Tel: 0044 1256 381944

www.audient.com

WARRANTY
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Service Information

iD14 contains no user-serviceable components, please refer to qualified service personnel 

for diagnosis and repair. Your warranty will be void if you tamper with the device at component 

level. If you have any questions with regard to the repair, please contact Audient Ltd.

If your unit is in warranty, please contact your dealer directly for a repair or replacement (at 

the discretion of the dealer).

For out of warranty repairs, please contact Audient Ltd, after which a Return Materials 

Authorization (RMA) number will be assigned. This number will serve as a reference for you 

and helps facilitate and expedite the return process. When the unit is returned please include 

this RMA number along with a description of the fault inside the packaging box.

To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or 

make an enquiry, please visit: www.audient.com/support

SERVICE
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A  Amperes
ADAT  Alesis Digital Audio Tape
ADC  Analogue to Digital Converter
DAW  Digital Audio Workstation
ASP  Analogue Signal Processing
CPU  Central Processing Unit
CUE  Artist Headphone Mix
DAC  Digital to Analogue Converter
dB  Decibel
dBu  Decibel referenced to 0.775Vrms = 0 dBu
dBFS  Decibel Full Scale
DC  Direct Current
D.I  Direct Injection (Instrument Input)
DoC  Declaration of Conformity
DSP  Digital Signal Processing
EQ  Equaliser
FAQ  Frequently Asked Questions
FCC  Federal Communications Commission
GB  Gigabyte
GUI  Graphical User Interface
HPF  High Pass Filter
HV  High Voltage
i/o  Input / Output
JFET  Junction Field Effect Transistor
LED  Light Emitting Diode
RoHS  Restriction of Hazardous Substances
RAM  Random Access Memory
S/PDIF Sony Philips Digital Interface Format
THD+N Total Harmonic Distortion + Noise
TRS  Tip Ring Sleeve (1/4” Jack Balanced)
TS  Tip Sleeve (1/4” Jack Unbalanced)
USB  Universal Serial Bus
V  Volts
XLR  Extra Live Return, Extremely Low Resistance, 
  Canon X Series, Latching, Resilient Rubber Compound... or make up your own!

GLOSSARY


